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The scanner and the bundled software comply with
TWAIN for the PC platform. For the scanner and
scanner software to perform suitably to task, you
should at least have:

 y  IBM PC or compatible with Pentium III-based
       processor

y  Windows® XP/Vista/7

y  Available USB port

y  SVGA color monitor

y  CD-ROM or DVD-ROM drive

y  At least 256 MB RAM

 y 150 MB available hard disk space for software
      installation

This chapter covers the scanner installation and has
the following topics:

y  System Requirements

  y  Unpacking the scanner

  y  Package contents

  y  The scanner parts

  y  Unlocking and locking the scanner

  y  Installing the scanner

  y  Installing TWAIN

1Setting Up the Scanner System Requirements

Setting Up the Scanner

Chapter One
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Carefully unpack the contents of the scanner
package.
Inspect the items closely and if you find any item
damaged or missing, please contact your Service
Center. Also, save the box and packing material for
in case you have to ship the scanner later.

Document
Cover

Scan Window
Glass

Carriage Lock
LED Power Indicator
LED Ready Indicator

 Power Switch

•  Document Cover
The document cover holds the document in place
during scanning. It can be raised when scanning
objects such as books.

•  Scan Window Glass
The scan window glass is where you lay down
and position documents for scanning. Alignment
marks and rulers are printed on the borders to help
you  position documents.

•  Carriage Lock
The carriage lock prevents the scanner’s internal
mechanism from moving during shipment. Unlock
the scanner before using and re-lock it when
shipping the scanner.

•  LED Power Indicator
When you turn on the scanner, the LED power
indicator flashes momentarily and then remains
lit.

Unpacking the Scanner

The Scanner Parts

Setting Up the Scanner

Chapter One
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•  LED Ready Indicator
When scanning or warming up, the LED ready
indicator will keep flashing. When the scanner is
available for scanning, the LED ready indicator
will remain lit.

•  Power Switch
Powers ON/OFF electrical power.

Setting Up the Scanner

Chapter One

Power Cord Receptable

USB Port

Transparency
Adaptor Port

•  USB Port
The Universal Serial Bus Port on the rear panel
are true plug-and-play serial ports for attaching
your scanner to your computer.

•  Transparency Adapter Port
This port is for connecting an optional transpar-
ency adapter.

•  Power Cord Receptable
Connect the scanner Power Cord to the Receptable.
This is used for your scanner’s power supply.
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Unlocking the Scanner
In the rear of the scanner is a carriage lock that
protects the scanning mechanism during shipping.
To prevent causing damage to the scanner, you should
unlock the carriage before operating the unit. As
shown in the illustration, push the carriage lock down
to release the carriage.

Locking the Scanner
In case you need to ship the scanner once after
installation, be sure to lock the carriage.
Failing to do so may cause damage to the unit’s
scanning mechanism. To lock the scanner, first
select Start, Programs, A3 scanner, “Scanner Lock”.
After successfully running the program, and the
carriage has stopped moving, you can now lock the
scanner by pushing the carriage lock up as shown in
the illustration. 

Setting Up the Scanner

Chapter One

Lock

Unlock

Lock

Unlock
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Installing the Scanner Driver
Please complete the software drivers installation
before installing the scanner. Do not connect the
power cord to the scanner at this stage.

1. Insert the Driver Instal-
    lation CD into your disk

drive.

2. Follow all on screen
    instructions.

If, after inserting the Driver Installation CD into your
disk drive, the Driver Installation Welcome screen
does not appear, do the sollowing:

a. Click on Start and select Run.

b. In the Run dialog box, type drive:\Autorun 
where driver is your CD-ROM drive and click OK.

Setting Up the Scanner

D:\Autorun

c. Follow all on-screen instructions.

When presented with the option of whether to
restart Windows after completing the software
drivers installation, please choose Yes.

Note: Do not use the “add hardware” icon to install
your scanner.

Chapter One
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Configuring the Software
In order to scan with your scanner driver, you must
first configure the TWAIN-compliant application
software that came with your scanner or which was
purchased seperately.
The configuration process only has to be done once.
After the configuration process is complete, the
TWAIN driver will control all interactions between
your scanner and the host program. To configure the
software:
1. Make sure the scanner is still on.
2. Launch Windows.
3. Launch the host application software that came

with the scanner.
4. Open the host application’s Select Source
  command (usually under the File menu) and
  choose Select Source to display the Select
    Source dialog box.
5. From the list of sources, choose your scanner

Setting Up the Scanner

as your image source and click Select. You will
return to the main screen of the host application.
Software configuration is now complete.

Network Scan
Enable users to search the installed A3 scanners in
the network and acquire images from this network
scanner.
Note: You must install TCP/IP Internet Protocol and
complete its required installation and setting.
To use the Network Scan:
1. When using any application program to Select

Source, choose Scanner-Network.

Chapter One
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Setting Up the Scanner

2. Select Acquire from the File menu (in some
programs, the Acquire command will appear in a
submenu under the Import command) and start
scanning and acquiring the images from the host
computer through the network.

Note: If you are acquiring the above source
(Scanner-Network) for the first time, the software will
process the search in the network so as to find the
host computer that has installed this scanner. The
dialog box representing searching process appears.

You can also call out this dialog box by selecting
Start, Programs, Scanner. When you run Host
Scanner for Network Command, Dialog 1 appears
first ,and then Dialog 2.

(Dialog Box 1)

Computers that have installed this scanner appear in
the dialog box 2. You will be asked to select one of
them to access its installed scanner.

(Dialog Box 2)

Chapter One
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Setting Up the Scanner

Chapter One

Installing Hardware
Refer to the following illustration and steps to
connect your scanner:

1. Connect the power adapter to the scanner and plug
it into an appropriate power outlet.

2. With the power to your computer on, connect the
scanner’s USB cable to the USB port of your
computer.

3. Connect the other end of the scanner’s USB cable
    to the scanner’s USB port.

Upon connecting the USB port, the Windows
Operating system would automatically detect your
scanner and update your system configuration.
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Just in Case it Happens

Upon installing the software drivers and connecting
the power adapter, if the Found New Hardware Wiz-
ard dialog box appears, perform the following steps:

          
    
 

                                                                  
     

Setting Up the Scanner

C

1. Click on the Next button.
2. Follow on screen instructions to complete the 
   installation procedures.
3. Found New Hardware Wizard will remind  
   you when the hardware installation is complete. 

Guyujiao
印章
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Setting Up the Scanner



A3 Scanner User Manual (PC)

11

Position the Document
For the best possible image scans, it is important that
you position your documents correctly and carefully.
For this tutorial, use a paper-based document such
as a color photograph. Procedures for document
positioning are as follows:

1. Lift the scanner document cover.
2. Place the document face down on the glass and

in the upper center corner.
3. Slowly lower the scanner document cover,
    making sure the document remains in position.

Power Up the Scanner
1. First, power up the scanner by pushing the power

button.

The LED power indicator on the front panel of
the scanner lights up and flashes for about a minute
and then remains lit, signifying that the scanner is
ready.

2. Power up the computer and wait until the
    computer finishes booting.

Scanning Tutorial
Scanning Tutorial

2

Chapter Two
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Using the Scanner Panel
The Scanner Panel is a useful tool for users to scan
in a quick and easy way. With its user-friendly
interface, you can perform scanning within seconds
and create your personal style with the scanned
images by using the bundled softwares, including
the following:

Batch Fax, Multi-Page Scan, Multi-Page OCR, Scan
to Save, Image Enhancement, JPEG 2000, Smart
Image Merge, Smart Photo Refresh, JPEG 2000
Viewer, Calibration Toolkit and Network Scan.
Following are the basic functions of the panel:

Scanning Methods
There are two separate methods to scan an image.
The Scanner Panel is ideal for quick and simple
scans, while the TWAIN Driver offers more control
over the output.

Status and Progress Bar Area
Shows the current state of operation on the Panel.

Scan
Click to start scanning.
Note: Status and Progress Bar Area shows warning
automatically when nothing is put on the scanner glass.

Copy
Click to call out a Panel and start copying.
Note: you can perform basic functions of copy machines
by changing the settings on the Setting Panel.

Fax
Click to first scan the document. Upon completion,
a panel appears on screen to fax.
Note: Advanced fax tools are provided  for final retouch-
ing. (e.g. move, rotate, add lines or texts and more.)

Email

Clicks to email the document with the image you
put on your scanner window glass.

Scanning Tutorial

Chapter Two
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Status and
Progress
Bar Area

The Scanner Panel

Settings

Help

Copy

Exit

Fax
Email

OCRPersonal
Style

Link

Scan

Scanning Tutorial

Chapter Two
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OCR (Optical Character Recognition)
Clicks to recognize the document with the images/
characters you put on your scanner window glass.

Exit
To exit (or close) the Panel, simply click on the
Exit icon.

Help
Help allows you to get information about the
various topics and procedures enabling you to use
and have a clearer understanding about your
scanner and its functions.

Personal Style
Allows you to make changes to your systems.

Link
To use the additional programs bundled with your scan-
ner, click on this button to call out the following items:

Bundled Software and Bonus features -
Additional programs bundled with your scanner to
enhance your image editing process.

Scanning Tutorial

Setting dialog box

For detailed information of how to use these
functions, please click the Help button on the panel.

Settings
Clicks to call out Settings dialog box and do your
favored settings.

Chapter Two
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Acquire the Scanner
TWAIN Driver
The TWAIN driver is the scanning module provided
with your scanner. It is easily accessed from within
the bundled scanner software or from within any
TWAIN-compliant program. Before you start with
the steps below, be sure you have installed and
configured the bundled scanner software. Refer to
Chapter 1 for details.

1. Launch Windows.
2. Run the host TWAIN-compliant software (e.g.

Photoshop)
3. Call up the TWAIN Data Source by selecting
     Acquire from the File menu. (In some programs,
    the Acquire command will appear in a submenu
  under the Import command.) The TWAIN
   dialog box will appear in a submenu under the
    Import command.

The TWAIN dialog box contains control settings,
which you must set prior to scanning a document.
The basic steps to scan a document are:
1. Prescan the document.
2. Set the desired image area to be scanned.
3. Select the scan source.
4. Select the desired scan mode.
5. Select the desired resolution.
6. Click on the Scan button.

Scanning Tutorial

Chapter Two
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Folders
Contain different
control settings

The Dialog Box
The TWAIN dialog box is divided into two sections: the left section where most of the control settings are
located, and the right section, which is the Preview Window.

Preview Window
Used for viewing the
prescan image and
selecting the final
scan area

Scanning Tutorial

Chapter Two
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Resolution
Sets the resolution in dots per inch
(dpi).

Output Scaling
Changes the dimensions of the
final output.

Scan Source
Sets the media type of the
document to be scanned.

Scan Mode
Determines how the scanner
will read the image and refers
to how the image will be
reproduced after it is scanned.

Photo Refresh
Photo Refresh allows you to  auto-
matically lighten and sharpen the
scanned image by clicking on its
icon. This function is applicable
when you are scanning images in
Color 24bit.

Descreen
Sets the media type of the document
to be scanned to reduce image
noise.

Image Size
Displays the amount of computer
space needed to display or save the
selected image area.

Scanning Tutorial

Scan Size
Refers to the size of the im-
age or document that you are
about to scan.
JPEG2000 Scan
The latest image compression
standard that usually provides
smaller file size and higher
image quality than the original
JPEG.
Width and Length
Show the dimensions of the
image area inside the Crop
Frame.

Color Matching Control
Color Matching allows the scanner
to more accurately reflect the actual
colors of the original image.

The Main Folder

Chapter Two
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Scanning Tutorial

Thumbnails
Are used to see the effects of
any changes in the control
settings.

The Enhancement Folder: Brightness/Contrast Control

Brightness Control
Allows you to adjust the overall
amount of light in the image
through a range of values (–127
~0~+127).

Channel Selector Control
Allows you to select the
channel layers (red, green
and blue) that make up a color
image. You can choose to
change the channels individu-
ally or choose master to
change all channels equally
and simultaneously.

Contrast Control
The Contrast Control allows you
to adjust the overall amount of
black areas or white areas in the
image through a range of values
(–127~0~+127).

Brightness/Contrast Control

Preview Button
This button allows you to see the
effect of any changes made to
the image prior to scanning. Any
changes will appear in the
preview window.

Chapter Two
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Level Control
Use the level slider to adjust an
image’s contrast and brightness.

Histogram
Shows the distribution of the
brightness levels in the image.

Eyedropper tools
Eyedroppers are used to iden-
tify an image’s highlights and
shadows.

Thumbnails
Are used to see the effects of
any changes in the control
settings.

The Enhancement Folder: Level Control

Channel Selector Control
Allows you to select the chan-
nel layers (red, green and
blue) that make up a color
image. You can choose to
change the channels individu-
ally or choose master to
change all channels equally
and simultaneously.

Level Control

Preview Button
This button allows you to see the
effect of any changes made to
the image prior to scanning. Any
changes will appear in the
preview window.

Chapter Two

Scanning Tutorial
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Curve Control
Applying a curve to an image
enhances favored brightness
ranges at the cost of others.
Add Anchor
To make a curve, simply place
an   anchor on the diagonal line
and adjust its position. Add
more anchors if you have to
make a more complex curve.

Remove Anchor
You can also remove anchors.

Thumbnails
Are used to see the effects of
any changes in the control
settings.

The Enhancement Folder: Curve Control

Channel Selector Control
Allows you to select the
channel layers (red, green and
blue) that make up a color
image. You can choose to
change the channels individu-
ally or choose master to change
all channels equally and
simultaneously.

Curve Control

Preview Button
This button allows you to see the
effect of any changes made to
the image prior to scanning. Any
changes will appear in the
preview window.

Chapter Two

Scanning Tutorial
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Thumbnails
Are used to see the effects of
any changes in the control
settings.

The Enhancement Folder: Hue/Saturation Control Control

Hue/Saturation Control

Preview Button
This button allows you to see
the effect of any changes
made to the image prior to
scanning. Any changes will
appear in the preview window.

Saturation Slider
Lets you adjust an image’s color
purity.

Hue Slider
is composed of two color bars.
The upper one is static and the
lower one movable. Slide the
latter, and you will see the image
shift its overall coloring.

Chapter Two

Scanning Tutorial
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The Filters Folder

None
No filter is applied.

Invert
Reverses an image to its
negative or compliment.

Flip
Creates a mirror image of
the original.

Blur
Smooths or softens the
image.

Emboss
Makes the elements in the
image appear raised or
sunken.

Sharpen
Enhances the detail in the
image.

Thumbnails
Are used to see the effects
of the selected filter.

Unsharp Mask
Emphasizes shape edges
and color boundaries.

Scanning Tutorial

Filter Control Buttons
Use these buttons to add
/subtract a degree of the
Blur or Sharpen filter.

The Filters Tab allows you to
adjust the individual effects of the
scanned image by applying
various filters to the image, prior
to scanning.

Chapter Two
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Batch Scan Button
Allows creation of up to 30 scan
regions (or Crop Frames) for
multiple scanning.

Crop Frame
Outlines the scan area or region
that will be included in the final
scan.

The Preview Window

Preview Button
Allows you to see the effect of
any changes made to the image
prior to scanning.

Zoom Tool Button
Allows you to enlarge/shrink an
area of the image in the preview
window

Scanning Tutorial

Cropping Tool
Selects the area in the Preview
Window that will be used as the
final scan. Language Setting

Allows you to select the desired
language that the dialog box will
be displayed in.
Help Button
Provides On-line Help.
Exit Button
Click to exit (or close) the TWAIN
or Batch Scan Dialog boxes.

Scan Button
processes the pre-scanned
image, and displays it in the host
software (where you opened up
the TWAIN dialog box).

Chapter Two
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Scanning Tutorial

Previous Button
Returns the most recent selection to its
previous setting. (Reloads the last saved
image settings.)

Reset Button
Returns settings to their default values.

Load Button
Loads previously saved image settings.

Save Button
Saves the current image settings.

Info Button
Lists information about the current settings
being used.

Chapter Two

Prescan the Image
A Preview is a quick low-
resolution scan of the entire
original image. From this low-
resolution scan you can get a
clearer idea of the image area you want to include
when you click Scan. To Preview, the steps are:

1.Place the document face down on the scan
    window glass.
2. Click the Preview button in the dialog box. After
     the scanner has scanned the document, the scanned
   image will appear in the Preview Window. From
  the Preview image, you can now set the exact
    image area you wish to include in your final scan.
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2. Select the scan source.
Since we are going to scan a color photograph,
choose Reflective.
Reflective:
when scanning paper-based documents such as
photographs or text (magazines, books, or images).
Negative/Positive:
when scanning positive film or transparencies, or
Negative as a source for scanning negative
film.(usually works with transparency adapter)

3. Select the desired scan mode.
The Scan Mode determines how the scanner will read
the image.
• 48-Bit Color captures images in 281 trillion colors
• 24-Bit Color captures images in 16.7 million colors
• CMYK captures images for output to a color printer
• 256 Color captures images in its optimum pallette
• 256Gray captures images in 256 grayscale

Scanning Tutorial

Chapter Two

Set Up the Scan Parameters
1. Set the desired image area to be scanned.

Use the Crop Frame in the Preview Window to
outline the image area you wish to scan. Click one
of the sides or corners of the Crop Frame and drag it
out or in to the desired length
and width.
To move the entire Crop
Frame, position the mouse
cursor inside it and drag with
the left mouse button.

Only the area inside the Crop Frame will be included
in the resulting scanned image when you click Scan.
The size information at the bottom of the dialog box
is automatically updated when the Crop Frame is
resized.

Crop frame
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Scanning Tutorial

Chapter Two

• Gray (16 bit) captures 16 bits of grayscale image
information for every pixel in the screen image

• Text/Line Art is used for text documents or black-
  and-white images

4. Select the desired resolution.
Resolution is a measure of how much image detail
information the scanner is to capture in a scan. A
higher resolution results to a sharper image but
requires more disk space for file saving. For this
session, set the resolution to 300 dpi.

Execute the Scan Command
When you are finished with the
control settings, click on the
Scan button. The scanner
begins to scan the document and a message box ap-
pears on the screen displaying the progress of the
scan.

When the scan is finished, the image will be displayed
in the main screen of the host software.
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Using Batch Scan
Batch scanning is an easy way to multi-scan any part
of your document using different scan modes and
resolutions. In batch scanning, you can specify up to
a maximum of 30 scan regions, or you can scan a
single region several times using different combina-
tions of scan modes and resolutions.

To activate batch scanning, click on the
Batch Scan button. This will bring up the
Batch Scan dialog box.

The Batch Scan Dialog Box
The Batch Scan dialog box contains several controls
that make batch scanning simple and easy to use. It will
also display the number of batch jobs that you make
when you create the scan regions.

Scanning Tutorial

Chapter Two
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• New Batch Button
  Click on this button to create a new
  scan region on the image in the
   Preview Window.

• Duplicate Batch Button
 Click on this button to duplicate a
 batch job. You can then specify
 different control settings for this
  particular batch job.

•  Trash Batch Button
 Click on this button to delete the
  selected or highlighted batch job.

• Cancel Batch Button
  Click on this button to cancel batch
  scan and exit the Batch Scan dialog
  box.

Chapter Two

Scanning Tutorial
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Calibrator
Contents and Requirements
Contents Checklist:
Before proceeding, please insure that all of the
contents from the list below have been included in
your package.

1. A3 Scanner User Manual
2. IT8 Target Image Color Card

If anything from the list above is missing or damaged,
please contact customer service to have it replaced.

System Requirements:
Pentium III Processor or higher
CD-ROM Drive
Windows XP/Vista/7
24-bit Video Card (or higher)
At least 256MB RAM
Minimum 150 MB available hard drive space

Introduction
Using the Calibrator

The Calibrator is a color calibrating program
provided with your scanner. It allows you to adjust
the color of the scanned images so that the
appearance of the image closely matches the colors
of your original  document.

All of the Calibrator’s functions are contained in easy
to use graphical interfaces based on the traditional
Windows format. Calibrating the scanner (or
scanner plus transparency adapter) is a simple task
that takes only minutes to complete.

About the Target Image

The target image included with this package is to be
used to create a scanner profile. The target image is
very important and must be handled with care, or the
calibration of your scanner may be adversely affected.

 Calibrator

Chapter Three

3
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We provide you the target image that can be used to
calibrate your scanner, the Reflective IT8. It allows
color matching for photographs and documents and
is used in conjunction with your scanner.

Target Image Handling:

 y Do not touch the image with your fingers. Handle
    it by the edges.

 y Keep the image away from light when not in use.
    This includes sunlight, interior light and light from
    the scanner lamp. Long exposure to light will fade
    the colors and affect accurate calibration.

 y  Return the calibration image to its protective sleeve
    immediately after use.

 y Store the calibration image by placing it face-
  down, away from light, in a cool, dry place.
   A good place to store it (both for protection and
   ease of memory) is inside the scanner box itself.

Calibrating and Applying
Calibrating the Scanner
Once you have successfully installed the calibration
software, you are ready to calibrate your scanner and
create a scanner profile.

To Create a Scanner Profile:
In Advance:
To ensure the quality of calibration, please do not open
the document cover during calibrating.

1. Make sure that your scanner is properly
    connected and powered on.

2. Turn on the PC and launch Windows.

3. Place the appropriate target image face down
   in the top center portion of the scanner glass.
   Make sure that the target image is correctly
  aligned on the scanner glass with the IT8
    indicators and TA indicators.

Chapter Three

 Calibrator
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5.  Click on the Calibrate button. The Calibration
       Wizard dialog box will be displayed. Click Next.

6.  Click the Scan button to start scanning.

Chapter Three

 Calibrator

IT8 Card

Note: It is very impotrant that you use the proper
Target Image Color Card.

4.  Access the Calibrator Wizard dialog box, which
    can be done in two ways:
I)  Selecting Calibrator from the Programs Group
     under the Start menu.
II) Selecting the Calibrator icon from the Bonus
     Features menu on the Scanner Panel.
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 Calibrator

Chapter Three

7. After the scanning is done, a Dialog box
   appears, asking you to start analizing the
     scanned picture (i.e. IT8 card).

Note: This dialog box shows whether you’ve put the
      card in the right position. If not, go back,
          reposition the card and scan again.

8.  A scanner profile appears and shows the result
   of calibration. You can choose whether to
     Finish, Retry or Abort.

The image will be scanned and a profile of the
calibration information will be saved to your hard
disk. This profile will be used by the computer to
automatically match the colors between scanned
images and the monitor.

Note: After you have successfully created a scanned
profile, you can match the colors of your scanned
images with this profile by checking the “Color
Match” box on the scanner TWAIN interface
(located in the Main Folder.)
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 Scanner Type: Color CCD Flatbed

Light Source: Cold Cathode lamp

Color Mode: true 48-bit/pixel

Gray Mode: true 16-bit/pixel

 Text/Line Art:  1-bit/pixel (2 levels)

Resolution
Optical: 1800 dpi (H) x 3600 dpi (V)

Software
Enhanced: 19200 dpi x 19200 dpi

Scan Area: 11.7” x 17” (297 mm x 431.8 mm)

Interface: USB 2.0

Dimensions: 27.0” (L) x 17.3” (W) x 6.4” (H)

Power
Consumption: 26.6 W

Weight: 15.5 kg (34.21bs)

Support OS: Windows XP/Vista/7

Option

TA/scan area: 11.7” x 17” (297 mm x 431.8 mm)

 Appendix

Appendix A: Specifications* A
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 Appendix

B

Appendix B

Ensure that your flatbed scanner operates at
optimum performance by observing the following:

• Cover the scanner when it’s not in use to avoid
  dust contamination

• Avoid environments where the scanner would be
  exposed to direct sunlight (or any other source of
  excessive heat) for long periods of time

• Protect the scanner from potential liquid spills such
  as soda, coffee, tea, etc.

• Operate the scanner on a level, well-grounded work
  surface, free of excessive vibration

• Be careful to avoid scratching the glass when
 placing multi-page documents (bound by sharp
  staples or paper clips) on the scan window glass.
  Scratches on the glass will show up as unwanted
   marks in scanned images.

• Don’t open the scanner case because there is
 danger of electrical shock and there are no
 customer-serviceable parts inside. For servicing
  needs, call your scanner dealer for assistance.
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Cleaning Procedures

1. Power off the scanner and disconnect the power
    cord.

2. Gently wipe the scan window glass with a soft
     lint-free cloth and mild liquid detergent to remove
   fingerprints, smudges, or loose particles. Do not
   use a spray detergent as this may get inside the
    case and damage the unit’s internal components.

3. Wipe off the detergent with a soft cloth damp with
    water.
4. Finally, dry the surface by wiping it with a clean
   soft cloth.
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Determining Error Messages
When the scanner is turned on, it will automatically
perform a series of self-diagnostic tests. The LED
power indicator located on the scanner’s front panel
should tell you if there is something wrong with the
unit. Upon power up, the LED ready indicator lights
up and flashes for about a minute and then remains
lit. The scanner lamp will also be on and will remain
on until you power off the scanner.

LED Ready Indicator Messages
1. If the LED ready indicator light continues to flash
    beyond one minute, call Technical Support.
2. If the LED ready indicator remains lit but the
    scanner lamp is dim, call Technical Support.

Other Troubleshooting
1. Check to make sure all cable connections are
    correct:
• The USB cable is firmly plugged into the scanner
  and the computer.
• The power cord is firmly connected to the scanner,
  plugged into an appropriate power outlet, and the
  power switch is turned on.
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